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The hybrid dictionary configuration in FLEx (FieldWorks Language Explorer, 
https://software.sil.org/fieldworks/) is based on the model of lexicography developed by the 
Mexico Branch of SIL and applied in an extensive series of published bilingual vocabularies and 
dictionaries in Mexican indigenous languages (www.mexico.sil.org/publications/i-vimsa), as 
well as for languages of other countries. The theoretical basis for this model is explained by 
Doris Bartholomew and Louise Schoenhals in Bilingual Dictionaries for Indigenous Languages 
(BDIL, www.mexico.sil.org/es/resources/archives/2384). 

Focus on the native speaker 

Unlike most models of lexicography, the MXB model is focused on the native speakers of 
indigenous languages as the primary users. Given that for many of them, the bilingual 
dictionaries we make will be the first ones produced in their languages, and that reading their 
languages is a relatively new experience, this model keeps the presentation of dictionary entries 
as simple as posible, especially at the beginning. Thus, for example, etymological information 
and lists of inflectional variants, such as plurals and past participles are presented after the basic 
information for each sense is presented, instead of after the headword, as is the common practice 
in dictionaries of international languages. 

Specifically, each dictionary article has the following general structure (BDIL, 25-26), where the  
field names in FLEx are given in bold. 

 1. Entry form in the vernacular: 

  a. Citation form, an actual word written in the practical ortholograpy; 

b. Pronunciation information (optional), e.g. tone information not included in the 
practical orthography. 

 2. Sense discriminations translated into the language of wider communication: 

  a. Grammatical category (Grammatical information) usually abbreviated; 

b. Translation equivalent (Definition) of the entry form in the language of wider 
communication. If there is no equivalent form, a clear and concise explanation 
(Definición descriptiva = Descriptive definition) of its usage is given, e.g. for 
grammatical morphemes; 

c. Qualifying comment (Restrictions) on the Definition, where necessary, to keep the 
translation equivalent (Definition) as short as possible; 

d. Illustrative sentence (Example) that demonstrates the use of the entry word in a natural 
context; 

  e. Natural free Translation of the sentence in the language of wider communication. 

These two types of information are essential to every entry. That is, the entry word and its senses 
make up the basic entry. All the other information that can be included is optional and amplifies 
the information included in the basic entry.  
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 3. Minimal linguistic information of three types: 

  a. The components of complex entries such as derived forms and compounds; 

  b. The conjugation class or “principal parts” of a paradigm (Inflectional Variants); 

  c. A grammatical clarification (Note) necessary for correct usage of the word; 

 4. Cross references of four types: 

  a. Pronunciation Variants (Var.); 

  b. Regional (dialectal) Variants, preceded by an abbreviation of the region where the 
      variant is used; 

  c. Synonyms or Antonyms, which are usually main entries; 

  d. References (Véase) to other words that are morphologically related. 

 5. Subentries which refer to other entries that share the same entry word: 

  a. Derivatives (e.g. nouns from verbs, transitive verbs from intransitive verbs); 

  b. Compound words utilizing the same root; 

  c. Idioms (idiomatic phrases) that include the entry word. 

Native speakers may not need or want to refer to the optional information provided by the last 
three types, but linguistically aware speakers and non-speakers, especially linguists, may find 
this information useful. 

In order to help the reader keep track of these different types of information, the MXB hybrid 
configuration maintains a distinction between citations from the indigenous language, which are 
always shown in boldface type; translations into the analysis language, which are always shown 
in regular type; and metadata or technical information, which is always shown in italics. In 
addition, colors are used in FLEx to help the compiler further distinguish between various types 
of information in the entry: Indigenous language citations are in blue, translations are in green, 
and metalanguage is in yellow (when referring to meaning) or red (when referring to 
grammatical form). 

Meaning in the basic entry 

Of the information provided in the basic part of the entry, the Citation form, the Definition, and 
optional Restrictions work together to provide a clear and concise presentation of the meaning 
of each lexeme. 

Citation form 

The focus on the native speaker begins by citing a form for each lexeme that is recognized as 
legitimate in a spoken utterance, rather than an abstract form from which it can be derived. For 
example, verbs are cited in the form closest to the “infinitive” in the language of wider 
communication, which could be the future or present tense for third person singular. 

This increases the chances that speakers will find the dictionary of interest to them, which in turn 
serves as an aid to literacy. Furthermore, with more and more native speakers of indigenous 
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languages compiling their own dictionaries, citing a naturally spoken form for each lexeme is 
much easier for them to manage than are abstract forms, especially in the early stages of analysis.  

However, it is often helpful to maintain a distinction between the Citation form, which is an 
actual spoken word, and the Lexeme form, which is an underlying or abstract root of the entry 
word. When this is done, the Lexeme Form and the Gloss are used for text analysis, while the 
Citation Form and the Definition are used for lexical analysis. 

Definitions and glosses 

Given that a bilingual dictionary does not have “definitions” such as those found in monolingual 
dictionaries of international languages, but rather translation equivalents in the language of 
wider communication, the MXB configuration makes a distinction between a Definition and a 
Gloss. 

One invariant gloss is ordinarily assigned to each root morpheme, both lexical and grammatical, 
as the “label” for that morpheme in the analysis language. These glosses are primarily used in 
glossing texts so that the analyst can keep track of homophonous morphemes and others which 
can easily be confused.  

In contrast, one or more translation equivalents in each analysis language are normally given as 
the definition of each sense of each lexeme in a bilingual dictionary. Focus on the native speaker 
is furthered by citing the equivalent word or words in the language of wider communication as 
the Definition of each sense of a lexeme. This teaches the user what is the most appropriate way 
to translate it when speaking the language of wider communication. 

Keeping distinct translation equivalents for each sense also makes it easier for the compiler to 
create the Reversal index in the language of wider communication. When these “definitions” are 
short, they are easily converted into headwords in the Reversal index, which would be much 
harder if the definitions were long and complicated, as in monolingual dictionaries. 

When there is no translation equivalent in the language of wider communication, the MXB 
configuration provides a custom field called Definición descriptiva (Spanish for “descriptive 
definition”). This field is used instead of a Definition. It is often useful for describing the 
meaning of grammatical morphemes. For example, the English suffix -graphy could be shown in 
following way in an English-Spanish dictionary: 

 -graphy  suf. s.   Indica la acción de escribir; p. ej. lexicography lexicografía; typograpy 
tipografía. 

This descriptive definition (in English: Indicates the action of writing; e. g. …) is normally 
followed by two short examples of the use of the affix in the given sense. Together, this 
descriptive definition plus the examples are punctuated as one grammatical sentence. This, plus 
the fact that the Descriptive definition occurs in italics, sets it off as clearly different from a 
translation equivalent. 

Qualifying comments 

Since translation equivalents between languages seldom share all the same senses, qualifying 
comments are often needed in the Restrictions field. These comments restrict the sense of the 
translation equivalent to the corresponding one in the indigenous language. For example, many 
languages have multiple words for “carry” depending on how the object is carried or what part of 
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the body is used to carry it. In these cases the dictionary compiler would translate each one as 
“carry” with the appropriate restriction, such as “on one’s back” or “in one’s hands.” 

The fact that these restrictions are in a separate field means they can also be used to qualify the 
indigenous lexemes in the Reversal index. For example, on the English side of an English-
Spanish dictionary database, the entry for “entry” could have one sense qualified as “in a 
dictionary.” 

 entry  n.  entrada (en un diccionario) 

Then, in the Spanish reversal index, the corresponding entry could use the same qualification on 
the English word (where f. stands for a feminine noun). 

 entrada  f.  entry (en un diccionario) 

The main difference between these two entries is which language comes first, but the restriction 
on the meaning of the sense in question is the same for both. 

Emphasis on illustrative sentences 

Another major distinctive of the MXB model is that it makes illustrative sentences a primary 
focus of the dictionary article (BDIL, xv). Illustrative sentences serve both the compiler of the 
bilingual dictionary and the user. 

During the process of eliciting illustrative sentences, the compiler becomes aware of sense 
discriminations, co-occurrence restrictions on classes of lexical items, or grammatical restrictions 
which might otherwise have been overlooked (BDIL, 59). 

For the user, the illustrative sentences serve more than one purpose. Native speakers will 
resonate with the naturalness of the examples and exclaim, “Yes, that’s the way we talk!” This 
provides a source of pride in their language and a means of demonstrating their unique form of 
expression to the outside world. 

For non-speakers, the illustrative sentences provide clear examples of correct morpho-syntactic 
usage in the language. They also open a window onto the indigenous culture which amply 
illuminates their unique form of thinking. Cultural observations (entered into the Encyclopedic 
information field) can provide further explanations of customs mentioned in the sentences. 

The rationale for the inclusion of illustrative sentences is explained further in chapter 9 of BDIL, 
where it is shown that they perform one or more of the following functions for each sense of 
each word: 

 9.1. They clearly delineate the area of meaning of the entry word. 

 9.2. They illustrate the use of the word in a correct grammatical context. 

 9.3. They distinguish between applicable and non-applicable senses and contexts of the gloss. 

 9.4. They clarify potential ambiguities due to multiple meanings of the translation equivalent. 

 9.5. They display the local culture and local literary style, providing a glimpse into the 
culture's unique worldview. 
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Other topics 

Although the parts of BDIL that refer to computational applications of the MXB configuration 
are now archaic, many valuable discussions of lexicographical topics are included, such as: 

 The lexical unit (chapter 1) 

 Three levels of lexical analysis (chapter 2) 

 The procedures of lexical analysis (chapter 3) 

 The psychologically natural citation form (chapter 5) 

 Practical criteria for selection of the citation form (chapter 6) 

 The translation equivalent in the language of wider communication (chapter 8) 

 Sense discriminations (chapter 10) 

 Qualifying comments (chapter 11) 

 Variant pronunciations and geographical variants (chapter 13) 

 Translation equivalents and refinement techniques (chapter 14) 

 The index in the language of wider communication (chapter 15) 

 Loan words in the bilingual dictionary (chapter 16) 

 Special grammatical designations for indigenous languages (chapter 18) 

 Essential linguistic information and cross-referencing (chapter 19) 

 Subentries (chapter 20) 

 Evaluation of the dictionary article (chapter 26) 

Conclusion 

The MXB configuration focuses on native speakers as the primary users of the dictionary. It does 
this by presenting first, within each entry, the information most relevant to them; by making use 
of spoken forms as citation forms; by providing translation equivalents in the language of wider 
communication, which may be qualified by restrictions; and by employing grammatically and 
culturally natural illustrative sentences and translations to illustrate sense discriminations. Over 
the last several decades, this method has proven effective in introducing the first bilingual 
dictionary into many indigenous communities in Mexico and elsewhere. 
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Appendix 1 

 The following examples of each type of entry (Main, Minor, and Complex Form) are taken from the 
“MXB modelo” project in which English is the vernacular language and Spanish is the analysis language. 
The configured format from the Dictionary view is shown first, then what fields are used in Lexicon Edit 
to properly enter the displayed information. A unique feature of this hybrid configuration is that Complex 
Forms can appear both as main entries and as subentries. 

Main Entry 

entry  s.  entrada (en un diccionario o vocabulario)  Many dictionaries contain entries for words that are no 
longer in use.  Muchos diccionarios contienen entradas para palabras que ya no se usan. (La costumbre de 
incluir palabras obsoletas es antigua.) 
[pl. entries]  Sinón. article 
 ♦ entry word  s.  palabra de entrada (en un diccionario o vocabulario) 
 

Lexeme Form  entry 
Morph Type  root 
Citation Form  entry 
Dialect labels (Entry) 
Complex Forms entry word 
Components 
Variant of 
Pronunciation 
Note     
Restrictions 
Summary Definition 
Cross References 
  Synonym  article 
Descripción Breve(*) 
 

□Sense 1 
Reversal Entries entrada 
Definition   entrada 
Restrictions  en un diccionario 
Grammatical Info.  sustantivo           ▼  
Example   Many dictionaries contain entries for words that are no longer in use. 
Translation  Muchos diccionarios contienen entradas para palabras que ya no se usan. 
Encyclopedic Info. La costumbre de incluir palabras obsoletas es antigua. 
Definición descriptiva(*) 
Comentario restrictivo(*) en un diccionario o vocabulario 
 

□Variants 
Variant Form  entries 
Variant Type  plural 
 

□Publication Settings 
Publish Entry in  Main Dictionary 
Show As Headword in Main Dictionary 
Subentries   entry word 

 An asterisk (*) indicates a custom field with a Spanish name. Descripción breve [“Brief 
Description”] is the entry level equivalent of Definición descriptiva [“Descriptive Definition”]; it is used 
for minor entries (as in the sample entry for -graphy shown on page 3). 
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 The cited Headword is always the Citation Form, if it exists; otherwise, it is the Lexeme Form. If 
the Lexeme Form is used for root forms to facilitate text glossing, the compiler should be sure an 
appropriate Citation From is also filled in for the dictionary headword. 

 The Pronunciation field is used to specify phonological details not evident in the practical 
orthography. It can take the form of a phonetic transcription (as shown below) or as tone patterns, such as: 
a-b.m.b. 

 The Note field is used for a grammatical or etymological observation (as shown below), not for 
semantic distinctions, which should be made in the Restrictions field. 

 Inflecctional Variants and Pronunciation variants create separate, minor entries which need to be 
completed with a Citation Form and a Summary Definition (as shown below).  

 The Publication Settings fields are used to include or exclude entries from a publication (Publish 
Entry in) or show or hide them as entries in a publication (Show As Headword in). Subentries can be 
manually sorted using the Subentries field. 

Minor Entry (Variant) 

entries [‘en.triz]  {pl. de entry}  entradas (en un diccionario o vocabulario) 
 

Lexeme Form  entries 
Morph Type  stem 
Citation Form  entries 
Dialect labels (Entry) 
Complex Forms 
Variant Type  plural 
Variant of   entry 
Components 
Pronunciation  ‘en.triz 
Note 
Restrictions  en un diccionario o vocabulario 
Summary Definition entradas 
Cross References 
Descripción Breve(*) 
  

□Publication Settings 
Publish Entry in   Main Dictionary 
Show As Headword in  Main Dictionary 

 Minor entries are created in the Variants section of a Main Entry by filling in the Lexeme Form and 
Variant Type. The headword of the Main Entry becomes the Variant of field of the Minor Entry. 

 All Variants that are cited in another entry of a Publication must be included in the Publish Entry in 
for that Publication. However, they do not have to be shown as headwords in that Publication. 

 If the Minor entry shows as a Headword, the rest of the Minor entry can be manually edited to include 
a Citation Form, any Dialect labels or Pronunciation desired, and a Summary Definition (with 
optional Restrictions) or optinally, a Descripción Breve. 
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Main Entry (Complex Form) 
 A Complex Form Entry is a Main Entry that has Components. When the first component is entered, 
the Component Form Type field shows up. In addition, the Show Subentry under field appears in the 
Publications Settings. The first component is shown there by default, but the user may decide whether to 
show the Complex Form as a subentry under all, only some, or none of its components. 

 All the information for subentries comes from the corresponding Complex Form entry: (a) the 
subentry form comes from the Citation Form; (b) the part of speech comes from the Grammatical Info. 
field(s) in the sense(s); (c) the definition comes from the Summary Definition field; and (d) the 
qualifying comment comes from the Restrictions field (the one immediately above Summary Definition, 
not the one in the senses). 

 Since the Restrictions field automatically serves as the qualifying comment for the vernacular word 
in the Reversal Index, the custom field Comentario restrictivo (“Restrictive Comment”) allows users to 
have a different qualifying comment on the vernacular side, as in the above examples. Otherwise, this 
field can be eliminated from view and the Restrictions field can be configured to serve as the qualifying 
comment on the vernacular side, too. 

entry word  s.  palabra de entrada (en un diccionario o vocabulario) The entry word of a dictionary article is 
usually written in the practical orthography.  Normalmente la palabra de entrada del artículo de un 
diccionario se escribe con la ortografía práctica. 
Se pronuncia con intonación de frase.  Véase entry, word 
 

Lexeme Form  
Morph Type  phrase 
Citation Form  entry word 
Dialect labels (Entry) 
Complex Forms 
Complex Form Type Compound 
Components  entry | word 
Variant of 
Pronunciation 
Note    Se pronuncia con intonación de frase. 
Restrictions  en un diccionario o vocabulario 
Summary Definition palabra de entrada 
Cross References 
Descripción Breve* 

 

□Sense 1 
Reversal Entries entrada: palabra de entrada | palabra: palabra de entrada 
Definition   palabra de entrada 
Restrictions  en un diccionario 
Grammatical Info.  sustantivo           ▼  
Example   The entry word of a dictionary article is usually written in the practical orthography. 
Translation  Normalmente la palabra de entrada del artículo de un diccionario se escribe en la  
ortografía 
     práctica. 
Encyclopedia information 
Definición descriptiva(*) 
Comentario restrictivo(*) en un diccionario o vocabulario 
  

□Publication Settings 
Publish Entry in  Main Dictionary 
Show As Headword in Main Dictionary 
Show Subentry under word 
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Reversal index 
The Headword for a Reversal Entry must be entered in the Reversal Entries field. In order to respect 
Spanish lexicographic tradition, the Headword should always be a single orthographic word. All 
Headwords from the same sense are entered in this line, each followed by a faint line that appears when a 
new word is entered. 

When the Definition is a phrase, it should occur as a Reversal Subentry under one or more Headwords. 
This is also indicated in the Reversal Entries field by this use of a colon: the word before the colon will 
become the Headword in the Reversal Index, and the words after the colon will become a Reversal 
Subentry under that Headword. 

The Restrictions field automatically serves as the qualifying comment for the vernacular word in the 
Reversal Index. 

The Reversal Index must be manually edited to include the appropriate parts of speech in Spanish. 

The following Reversal Index entries show what the Reversal Entries fields in the above entries would 
produce, with the appropriate Spanish category added. 

… 

entrada  f.  entry (en un diccionario) 
♦ palabra de entrada  entry word (en un diccionario) 

… 
palabra  f. 

♦ palabra de entrada  entry word (en un diccionario) 
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Appendix 2 

Although FLEx allows the user to export a configuration from one project and import it into another, this 
process changes many other things, including the Grammatical Categories, some of the Styles, and some 
of the lists, such as Complex Form Type. For this reason we do not recommend exporting and importing a 
configuration at this time (FW8.3.10). 

Instead, we currently recommend using the Hybrid configuration that now comes with FLEx as a third 
option, besides Lexeme-based and Root-based. It is based on the MXB configuration, but not all the 
details are the same. The following specifications are necessary to modify the standard Hybrid 
configuration to conform to our MXB norms for research and publication. For best results, they should 
applied in the order indicated. 

First, use Tools > Configure > Dictionary to choose the Hybrid configuration: 
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Second, in Lexicon Edit, use Tools > Configure > Custom Fields to create the following three custom 
fields: 

 

These fields all have Spanish names (including accents) and the following specifications: 

Custom Field Name Location Description Type List Writing 
System(s) 

Descripción breve Entry Only used when there is no translation 
equivalent in the Summary Definition 
of a Minor Entry. 

Single-line 
Text 

— — (*) 

Definición descriptiva Sense Only used when there is no translation 
equivalent in the Definition of a Main 
Entry. 

Single-line 
Text 

— — (*) 

Comentario restrictivo Sense Qualifying comment to restrict the 
meaning in the Definition field of a 
Main Entry. 

Single-line 
Text 

— — (*) 

 (*) Specified in the Configuration. 
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Third, use Format > Styles to be sure they are correct: 

 

In the Font tab, click on each of the following styles and modify the information as specified (where “—” 
indicates neither checked nor blank): 

Type Style Size Color Bold Italic Subscript 
a Dictionary-Contrasting 10 Dark Yellow no yes — 
a Dictionary-CrossReferences 10 Blue yes no — 
a Dictionary-Headword 11 Blue yes no — 
¶ Dictionary-Normal 10 Black — — — 
¶ Dictionary-Pictures 10 Black — — — 
a Dictionary-POS 10 Dark Red no yes — 
¶ Dictionary-Sense 10 Black — — — 
a Dictionary-SenseNumber — Black yes no — 
¶ Dictionary-Subentry 10 Black — — — 
a Dictionary-Vernacular 10 Dark Blue yes — — 
a Emphasized Text 10 Spanish: Dark Yellow 

English: Plum 
vernacular: Dark Blue 

no 
no 
yes 

yes 
no 
no 

— 
— 
— 

¶ Homograph-Number — Blue yes no yes 
¶ Normal 10 Spanish: Green 

English: Plum 
vernacular: Dark Blue 

— 
— 
— 

— 
— 
— 

— 
— 
— 

a Reversal-Headword 11 Spanish: Green 
English: Plum 

— 
— 

— 
— 

— 
— 

¶ Reversal-Normal 10 Black — — — 
¶ Reversal-Sense 10 Black — — — 
¶ Reversal-Subentry 10 Black — — — 
a Reversal-Vernacular 10 Dark Blue yes no — 

If one of the styles in this list does not exist, you can create it with the Add or Copy button. 
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Fourth, use Tools > Configure > Dictionary to configure the individual fields in both Main entries and 
Minor entries as follows. 

For Main entries, check for the appropriate fields in Senses: 
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Also for Main entries, check for the appropriate fields in the References Section: 
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For Minor entries, check for the appropriate fields as follows: 
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Summary 

Surrounding text 
 Field   Before  Between After 
Entry Paragraph 
 Headword      fixed space(*)  
 Pronunciation  “[”    “]”, fixed space 
Sense Paragraph 
 Sense number  space    “.” 
 Category  space    fixed space 
 Definition  space    fixed space 
 Comment      fixed space 
 Example  space    fixed space 
 Translation  space    fixed space 

Encyc. Inf.  space  
Reference Paragraph 
 Component ref.      fixed space 
 Note   space    fixed space 
 Inflectional var. space, “[”  “;”  “]”, fixed space 
 Cross ref.  space    fixed space 
(*) Shows as as [NBSP] in FLEx. 

Spacing 

        a. There should be two spaces between each “segment” of the entry: Headword; Category; 
Definition; Example; Translation; References. 
        b. There should be one space between “parts” of segments: Headword & Pronunciation; Senses 
Number & Category (or Definition); Definition & Restriction; Variant Label & Variant Form; Reference 
Label & Reference Form. 

Senses paragraphs 
        a. For entries with multiple senses, the first sense should follow the definition without a paragraph 
break. All subsequent senses should start with a paragraph break. 
        b. Subsenses should be concatenated and joined by a comma and space. 

Reference paragraph 
        a. Component references with one space between Complex Form Type ("Comp. de" or "Deriv. de") 
and Referenced Headword. 
        b. Note (free form grammatical observation, punctuated as complete sentence) 
        c. Inflectional variants: [abr1, form1; abr2. form2] 
        d. Cross references ("Sinón.", "Antón." or "Véase plus form) 

   e. Pronunciation variants (same dialect; "Var." plus form) 
   f. Regional variants (different dialects; "Dial. Q." plus form) 

Subentries 
Configure as separate, bulleted paragraphs, further indented than the entry paragraph and with hanging 
indent. 

Examples 

The following excerpt is from the Diccionario mixteco de San Andrés Yutatío, Tezoatlán, Oaxaca. [Serie 
de vocabularios y diccionarios indígenas “Mariano Silva y Aceves” 49]. 



A a
á adv. 1. Indica pregunta cuya respuesta

es sí o no. ¿Á ni ̱kuitá ní? ¿Ya se
cansó usted?
2. Puede presentarse dentro de la
oración. Ni ̱saꞌaṉ xi ̱ni ̱sa ̱ndeꞌ̱é xí á
ndéi chee̱. Fue a ver si están los
toros. (Lit. Fue a ver: ¿Están los toros?)

a̱ {var. de o}̱ no
achá s. esp. hacha

achá
ada̱ adj. 1. simple (sabor, que le falta

dulce o sal) Ada ̱ndavaꞌ̱o yíki ̱ni ̱
dac̱hóꞌo ̱ná, chi ̱ko ̱taꞌ̱ón suká ña.̱
Está muy simple la calabaza que hizo,
porque no tiene azúcar.
2. desagradable (olor) Ada ̱ndavaꞌ̱o
sáꞌaṉ noó̱ ñóꞌo kíti.̱ Huele muy
desagradable el lugar de los chivos.

á dáá vá interj. ¿de veras? (indica
asombro) —Kanaꞌá ndó chi ̱ni ̱noo va
yaꞌ̱i mvélo.̱ —¿Á dáá vá? ¡Ndeí koo
ví ri!̱ —Sepan ustedes que el precio
de los sombreros bajó. —¿De veras?
¡Qué lamentable!

adi ̱ adj. rico, sabroso Adi ̱ndavaꞌ̱o
tiy̱iki. Son muy sabrosas las semillas
de calabaza.

adi ̱ini na̱ adj. con apetito Adi ̱
ndavaꞌ̱o ini taleé ndu̱, vaꞌ̱a ndaꞌ̱o seí
xi ñaꞌ̱a. Nuestro niño está con apetito;
come muy bien.

amigó s. esp. amigo

[voc. migóo]̱
-aṉ {var. de ñaña2̱ñá} que
ánío̱ {var. de nío}̱ corazón
a ̱ñáꞌa̱ {var. de o ̱ñáꞌa}̱ todavía no
ao adv. año pasado Ao ni ̱xiti na

ndúchi,̱ tído ko ̱ní xíti ka ̱na ̱ñá kuia̱
viti. El año pasado sembraron frijol,
pero este año ya no.
Var. kuia ̱ao

ati adj. de sabor fuerte (que deja la
lengua escaldada) Ati ndavaꞌ̱o mangó
chi ̱yúta ̱ri.̱ El mango, cuando está
tierno, tiene un sabor fuerte.

Ch ch
cháá 1. adj. poco Ná kiꞌ̱o tóoi ña ̱cháá

vá kuu̱, chi ̱ió̱ choon kuu mií
ndúaṉ. Se lo presto por pocos días,
porque también lo necesitamos
nosotros.
2. adv. un poco Ió vaꞌ̱a cháá vá ini
xi.̱ Se siente un poco mejor.
3. adv. un poco más (para que sea
normal) Kueé cháá ní kaꞌoṉ. Habla
un poco más despacio.
4. adv. por un momento Ná yaꞌ̱a
chááí noo ̱ní. Permiso, voy a pasar.
(Lit. Voy a pasar un momentito enfrente
de usted.)
♦ ndée ̱vaꞌ̱a cháá adj. más fuerte

cháá daá ní interj. es suficiente Cháá
daá ní kadikí ndo,̱ kuáchí. Vaꞌ̱a ka̱
naniꞌi ̱ndée ̱ndo.̱ Es suficiente de
juego, niños. Mejor descansen.

cháá díón ní adv. así no más, basta
Cháá díón ní ñii ̱taaoṉ noo ̱ndúchi,̱



chi ̱kuꞌoꞌov̱aṉ. Échale así no más
porque, si no, se va a salar el frijol.

cháá ka̱ adj. más ¿Á kóni ̱ní cháá ka̱
dita?̱ ¿Quiere usted más tortillas?
Comp. de cháá, ka2̱ Var. cháá ga̱
♦ sav̱aꞌa cháá ka̱ adj. mayor que

otro
cháá ka ̱noo̱ adv. más adelante Cháá

ka ̱noo ̱íin veꞌi. Más adelante está mi
casa.
Var. cháá ka ̱chí noo̱

cháá ka ̱tóó adv. al rato Cháá ka ̱tóó
saai̱ ̱koto niꞌini yoꞌ̱ó. Al rato voy a
llegar a visitarte.
Var. cháá tóo ka,̱ tóó cháá ka̱

chachi interj. Se dice para espantar a los
perros para que salgan. ¡Chachi kíi ̱ri ̱
saṟvéꞌe! ¡Sácate afuera!
Var. yachi ̱ri ̱

chachi ña {var. de kuachi ña} ser
despedazado

cháchi ña {pres. de kuachi ña} es
despedazado

chav̱ádo̱ s. esp. 1. chavado (tipo de rifle
antiguo y doble resistente, reg.)
2. Indica un tipo de pistola.

chee̱ s. 1. buey, novillo
2. yunta Koꞌiṉ xíꞌín chee̱i ̱naꞌa
dataaṉ kasáꞌan rí, dá kuti rí. Me
voy con mi yunta en la madrugada
para que coma antes de sembrar.
♦ koṉ̃o chee̱ carne (de res)
♦ ta ̱ndáka chee̱ s. pastor, vaquero
♦ tiṉdóo ̱chee̱ s. tarántula

chee̱

chee̱ yúta̱ s. novillo
chéli s. gallo

chéli
chernee na {var. de chirnee na}

poner (de forma horizontal); enchufar;
tender (ropa); comprometerse (fig.)

chí prep. por (señalamiento) Chí káa
diꞌa kuaꞌán ní. Vaya usted por allá.

chi1̱ conj. porque, pues Ná koꞌiṉ chi ̱
¿ndá orá ví ndikoi? Me voy, porque
si no, ¿a qué hora voy a moler?
♦ dá chi ̱ porque

chi2̱ part. 1. a poco, a caso (indica duda
o asombro) ¿Á katiꞌ̱a mií ní chi?̱ ¿A
poco va a poder hacerlo?
2. Indica asombro o alarma. Táan chi,̱
táan chi.̱ ¡Está temblando! ¡Está
temblando!
♦ káchi ̱ interj. ¡mira allá!
♦ ñoó chi ̱ interj. Expresión de

asombro causada por un ruido.
♦ yóchi ̱ interj. ¡mira aquí!

chi3̱ part. 1. Indica que está hablando de
parte de otra persona. Juan, ¿á koꞌoṉ
ní kadikí ní xíꞌín tatái?̱ chi.̱ Juan,
pregunta mi papá si va a jugar con él.
2. Indica que está diciendo lo que dicen
otras personas. Kasaa ̱ta ̱néꞌe choon
káꞌano ñoo yo ̱iin ka ̱semana chi.̱
Dicen que la próxima semana vendrá
el gobernador al pueblo.

chi- pref. Indica causativo en ciertos
verbos y adverbios, por ejemplo:
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chideꞌ̱é-na̱ esconder; chisáꞌá-ná
patear.

chiꞌan s. maldición Chiꞌan tái ̱na ̱saꞌ̱á
ñoó̱ ko ̱ndóꞌo vaꞌ̱a na. Sufre
maldición, por eso no le va bien.
♦ katai ̱chiꞌan na v. i. estar

maldecido
chíchí adv. para siempre Ni ̱ndusáa̱

chíchí vá ná kandei na. Regresaron
a vivir aquí para siempre.

chic̱hi s. canal (de riego) Ndáñoo ra
chic̱hi ra,̱ dá kasndaá vaꞌ̱a taḵuií̱
noo ̱ñóꞌo ̱rá. Ellos limpian su canal de
riego para tener más agua en su
terreno.

chíchi na1 {pres. de kuchi na1} está
masticando

chíchi na2 {pres. de kuchi na2} está
bañándose (con agua)

chic̱hi ña v. i. 1. madurar (fruta) Sa ̱ni ̱
chic̱hi vaꞌ̱a ndíka.̱ Ya se maduraron
bien los plátanos.
2. madurar (persona, fig.) Ni ̱chic̱hi
vaꞌ̱a na xíꞌín ña ̱vaꞌ̱a, chi ̱vaꞌ̱a ndaꞌ̱o
kée na. Esta persona maduró en
carácter para bien, porque hace cosas
buenas.
[pres. chíchi ña; pas. ni ̱chic̱hi ña]

chíchi táꞌan noꞌ̱o na {pres. de kuchi
táꞌan noꞌ̱o na} están rechinando (los
dientes)

chichí xí v. i. mamar Chíchí naꞌá xí,
chi ̱ko ̱taꞌ̱ón táꞌan xi ió yachi.̱ Ha
mamado pecho por mucho tiempo
porque no tiene hermanito.
[pres. chíchí xí; pas. ni ̱chichí xí]
♦ dáchíchí ná v. t. dar de mamar

chidáó ná v. t. comparar Chídáó ná
dáꞌoṉ, ndeꞌ̱á á iin noó̱ ndáan.

Comparen las telas para ver si son
iguales.
[pres. chídáó ná; pas. ni ̱chiḏáó ná]

chidáó táꞌan na v. recíp. competir Ni ̱
chiḏáó táꞌan na ni ̱kav̱aꞌ̱a na mvélo.̱
Ellas compitieron haciendo
sombreros.
[pres. chídáó táꞌan na; pas. ni ̱chiḏáó
táꞌan na]

chideꞌ̱é na̱ v. t. esconder Ni ̱chiḏeꞌ̱é
na ̱diꞌ̱ón tix̱i ñóꞌo.̱ Ellos escondieron
el dinero bajo tierra.
Deriv. de deꞌ̱é [pres. chídeꞌ̱é na;̱ pas.
ni ̱chiḏeꞌ̱é na]̱

chídí adj. llorón, chillón Chídí ndaꞌ̱o
taleé páꞌa.̱ Es muy llorón el bebé
recién nacido.

chidiꞌ̱i ̱ s. murciélago Iin ndakána
chíkaꞌanda chidiꞌ̱i ̱noó̱ ndíko ̱vúrro,
ta kúú túꞌu va rí nii ̱doꞌ̱o rí. De
repente pasa el murciélago por donde
está amarrado el burro y le chupa la
sangre de la oreja.

chidiꞌ̱i ̱
chido̱ s. mayate (insecto verde)

chido̱
chii s. chorro Tánee chii taḵuií̱

tikuiiṉ yuu̱ káa. Entre esas piedras
sale un chorro de agua.

chíiṉ s. uña, garra
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♦ kani chíiṉ ná v. t. rasguñar,
pellizcar; clavar (la uña)

chiꞌi na v. t. 1. plantar (semillas),
sembrar Chíꞌi na rávano, dá kanaan
keí náán xíꞌín dita ̱ná. Ellos
siembran rábanos para comer con sus
tortillas.
2. poner (zapatos o huaraches) Chíꞌi
na ndisa ̱saꞌ̱á deꞌ̱e na. Le está
poniendo los zapatos a su hijo.
3. poner (adentro), meter Chíꞌi na
ñoo ̱káꞌa ̱mvélo ̱ná. Al comenzar a
tejer un sombrero, él mete tiras de
palma en la base de la copa del
sombrero.
4. untar, poner Chíꞌi na kremá ñíi ̱
ná. Ella se pone crema en la piel.
5. lavar (cabello) Koꞌiṉ chiꞌi diṉií̱.
Voy a lavarme el cabello.
6. invertir (en un negocio o un bien)
Vaꞌ̱a ka ̱ná ndukú yó noó̱ chiꞌi yó
cháá diꞌ̱ón yo,̱ chi ̱kasndaá iin kuu̱
konñóꞌó yóaṉ. Es mejor tratar de
invertir nuestro dinero en algo; pues
un día lo vamos a necesitar.
[pres. chíꞌi na; pas. ni ̱chiꞌi na]
♦ nachiꞌi na v. t. guardar; poner

(zapatos, huaraches, calcetines);
inscribir

chiꞌiṉgi ̱ s. bellota (del encino) Kána
chiꞌiṉgi ̱noó̱ taṉdií̱ xíꞌín noo ̱tay̱atá.
Salen bellotas de los árboles de encino
amarillo y de encino chaparro.

chiꞌi niꞌini na v. t. sembrar (no en
orden o en un surco)
Comp. de chiꞌi na, niꞌini [pres. chíꞌi
niꞌini na; pas. ni ̱chiꞌi niꞌini na]

chíꞌi ̱ñóꞌo̱ adv. muy pequeño Leé chíꞌi
ñóꞌo ̱ndíki ̱líto. Están muy pequeños
los cuernos del chivito.
Siempre sigue la palabra lóꞌo̱ o leé.

chiꞌio̱ṉ s. espuma Kána chiꞌio̱ṉ yúꞌu̱
chee̱, tá xíti rí. Sale espuma de las
bocas de los bueyes cuando están
trabajando en la siembra.

chiꞌio̱̱n
chikaa ̱ini na̱ v. t. decidir, pensar

(hacer algo) Ni ̱chíkaa ̱ini na ̱diḵó ná
iin chee̱. El decidió vender un buey.
[pres. chíkaa ̱ini na;̱ pas. ni ̱chiḵaai̱ni
na]̱

chikaa ̱na̱ v. t. 1. poner, echar
(adentro), meter (complemento singular)
Chikaa ̱ña ̱noó̱ xeꞌe.̱ Échalo a la
basura.
2. poner (a sí mismo o a otra persona)
Chíkaa ̱na ̱déꞌe ̱ndáꞌa ̱ná. Ella pone
el anillo en su dedo.
[pres. chíkaa ̱na;̱ pas. ni ̱chiḵáa̱
na]̱ Véase taán ná
♦ nachikaa ̱na̱ v. t. volver a echar;

colocar
chikaꞌanda na̱ v. i. 1. pasar (de un

lugar a otro) Yóꞌo chíkaꞌanda
kamión sáꞌaṉ Ñaḏeen. Por acá pasa
el carro que va para Huajuapan.
2. pasar (un camino) Kuaꞌán ní
nakiꞌ̱in ní keí chíkaꞌanda káa, koꞌoṉ
ní. Toma la calle que pasa por allí.
[pres. chíkaꞌanda na;̱ pas. ni ̱
chiḵaꞌanda na]̱ Var. chiokaꞌanda na̱
♦ dáchíkaꞌanda na v. t. hacer que

pase, traspasar
chiḵáꞌano adj. grandísimo, enorme Ni ̱

xiin yuꞌu̱ iin ñóꞌo ̱chiḵáꞌano.
Compré un terreno grandísimo.
Deriv. de káꞌano Véase chiṉáꞌano
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choꞌo̱ s. nido, morada (de animales
como conejo, venado, guajolote, gallina)

choꞌómá s. Indica una especie de avispa
grande.

choon s. 1. trabajo ¿Ndá choon kée
ndó? ¿Qué trabajo hacen?
2. mandado Kuaꞌaṉ talóꞌo ̱choon
naná xi.̱ El niño va al mandado de su
mamá.
3. autoridad, cargo Ni ̱niꞌi ̱ná iin
choon káꞌano kaneꞌe na. Consiguió
un cargo importante para ejercer.
♦ kaꞌanda na ̱choon v. t. ordenar,

mandar
♦ kaki na ̱choon v. i. demandar
♦ kani choon noo ̱ná v. t. tocar,

corresponder (a alguien su turno o
un cargo)
♦ kechóon na v. i. ; v. t. trabajar;

servir; utilizar
♦ ko ̱chóon kuu na ña̱ v. t. no

ocupar, no emplear
♦ ko ̱chóon ña̱ v. i. no sirve
♦ koo choon ña̱ v. i. ; v. t. ser útil;

ocupar
♦ ndaꞌá chóon s. herramientas,

materiales (de construcción o de
cocina)
♦ taꞌaṉda ̱choon noo ̱ná v. i.

recibir órdenes
♦ tandaꞌá ná choon v. t. mandar,

enviar (razón)
♦ ta ̱néꞌe choon s. hombre (con

autoridad en el gobierno)
♦ veꞌe chóon s. agencia, palacio

(municipal)
choꞌon ini na̱ v. i. esforzarse, intentar

Ni ̱choꞌon ini xi ̱ni ̱kav̱aꞌ̱a xi iin
dosená mvélo.̱ Ella se esforzó en
hacer una docena de sombreros.

[pres. chóꞌon ini na;̱ pas. ni ̱choꞌon
ini na]̱

choꞌon na v. t. peinar Chóꞌon na dini ̱
ná xíꞌín kuika.̱ Está peinándose (lit.
peinando su cabeza) con un peine.
[pres. chóꞌon na; pas. ni ̱choꞌon na]

choꞌon taa̱ ini na̱ v. t. esforzarse (a lo
máximo) Ni ̱choꞌon taa̱ ini na ̱saꞌ̱á
ñoó̱ ni ̱kandeé ná ni ̱xiti na uxi ̱
makilá ñóꞌo.̱ Se esforzó a lo máximo,
por eso pudo sembrar diez maquilas de
terreno.
[pres. chóꞌon taa̱ ini na;̱ pas. ni ̱
choꞌon taa̱ ini na]̱

choꞌo ̱ñá v. i. cocerse ¿Á sa ̱ni ̱choꞌo̱
koṉ̃o?, chi ̱kuíkoi, kiꞌ̱o lóꞌo.
Hermana, ¿ya está cocida la carne?
Porque tengo hambre.
[pres. chóꞌo ̱ñá; pas. ni ̱choꞌo ̱ñá]
♦ dáchoꞌo ̱ñá v. t. cocer; digerir

choꞌo ̱yókó ñá v. i. cocerse (al vapor)
Chíkódó ná iin tuꞌu yio iti ̱noo ̱xóo̱
ná; dá dádaꞌ̱i naaṉ xíꞌín iin koꞌo;̱ dá
chóꞌo ̱yókó ñá seí na.̱ Ellos ponen un
puño de quelite en el comal; lo tapan
con un plato y se cuece al vapor.
Comp. de choꞌo̱ ñá, yoko1̱ [pres.
chóꞌo ̱yókó ñá; pas. ni ̱choꞌo ̱yókó
ñá]
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chitó
chito̱ s. lama, alga Ñóꞌo ndaꞌ̱o chito̱

noó̱ taḵuií̱ ini miṉi káa. Hay mucha
lama en el agua de esa hondura del
río.

chitó ná v. t. besar Ni ̱chitó ná noo̱
taleé lóꞌo ̱na.̱ Él besó a su bebé en la
mejilla.
[pres. chító ná; pas. ni ̱chitó ná]

chitóꞌoṉ na̱ v. t. partir, mochar (en
dos) Deé̱n ndaꞌ̱o machití na;̱ iin ni ̱
chiṯóꞌoṉ va na iin títo.̱ Su machete
tiene mucho filo; de un tajo partió en
dos un leño.
[pres. chítóꞌoṉ na;̱ pas. ni ̱chiṯóꞌoṉ
na]̱

chitó yukú s. gato montés Náꞌano
ndavaꞌ̱o chitó yukú noo ̱chiṯó ndáka
na. Los gatos monteses son más
grandes que los gatos domésticos.

chituu ini na̱ v. i. controlar, detener
(deseos) Kátoó na ̱keí ná yáꞌa,̱ tído
chítuu ini na,̱ dá chi ̱xíꞌi na tata.̱ A
él le gusta comer chile, pero controla
sus deseos porque está tomando
medicina.
[pres. chítuu ini na;̱ pas. ni ̱chiṯuu ini
na]̱

chituu na v. t. detener, parar (una
actividad o un movimiento) Ni ̱chiṯuu
va ta ̱néꞌe choon ta ̱ñoo, chi ̱koo
juntá. La autoridad detuvo las labores
de los hombres del pueblo porque
habrá una reunión.

Deriv. de katuu na [pres. chítuu na;
pas. ni ̱chiṯuu na]

chituú na̱ v. t. envolver, forrar Koꞌiṉ
chituúi ̱ndáꞌa ̱taleéi,̱ dá ná kudi ̱naꞌá
xí. Voy a envolver a mi bebé para que
duerma mucho tiempo.
[pres. chítuú na;̱ pas. ni ̱chiṯuú na]̱

chí vaá̱ adv. por el lado este, por el
lado oriental (de un pueblo)

chí xoo adv. por el lado norte (de un
pueblo)

chiyaꞌ̱i na v. t. pagar Ni ̱chiy̱aꞌ̱i na
taa̱ ni ̱kavaꞌ̱a veꞌe na. Ellos le
pagaron a un hombre que construyó su
casa.
Deriv. de yaꞌ̱i [pres. chíyaꞌ̱i na; pas. ni ̱
chiy̱aꞌ̱i na]

chiy̱ángí s. arco iris Tá koon kuálí
dai ̱tá ndií, kúú sá kuíiṉ chiy̱ángí
noo ̱yúku̱, ta kúú nóma ̱vá dai;̱ ko̱
kóon ka ̱ra. Cuando hay sol y cae
llovizna, luego se pone el arco iris en
el monte y para la llovizna; ya no
llueve más.

chiyeé ñá v. i. infectarse Ni ̱taán ná
kaka noó̱ ni ̱tarkueꞌ̱e ̱tix̱i kíti ̱ná, chi ̱
yu̱ꞌú na ̱chiyeéán. Echaron cal en la
herida que tenía el chivo en el
estómago por temor a que se le
infectara.
[pres. chíyeé ñá; pas. ni ̱chiy̱eé ñá]

chiyúú ná v. t. apedrear Ni ̱chiy̱úú ná
iin koo.̱ Él apedreó a una serpiente.
Deriv. de yuu̱ [pres. chíyúú ná; pas. ni ̱
chiy̱úú ná]

choo̱ s. Indica la parte superior de la
espalda en la región del omóplato.
♦ kaꞌá choo̱ s. lomo
♦ saꞌá choo̱ s. espalda
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chikaꞌaṉo ̱na̱ v. t. doblar Ni ̱
chikaꞌaṉo ̱vaꞌ̱a na dáꞌoṉ. Dobló la
ropa.
Deriv. de kaꞌaṉo̱ na̱ [pres. chíkaꞌaṉo̱
na;̱ pas. ni ̱chiḵaꞌaṉo ̱na]̱
♦ nachikaꞌaṉo ̱na̱ v. t. doblar

chikaa ̱vaꞌ̱a na v. t. guardar
(complemento singular)
[pres. chíkaa ̱vaꞌ̱a na; pas. ni ̱chiḵáa̱
vaꞌ̱a na] Véase nataán váꞌa na

chiḵáni ̱ adj. muy largo, muy alto
[pl. chiṉáni]̱

chikani kuití na̱ v. t. amontonar (una
cantidad) Sa ̱ni ̱chiḵani kuití na ̱ñoṯí
xíꞌín yuu̱, dá kuaꞌaṉ na ̱kavaꞌ̱a na
veꞌe na. Ya amontonaron arena y
piedras; después van a empezar a
construir su casa.
[pres. chíkani kuití na;̱ pas. ni ̱chiḵan
ikuití na]̱ Sinón. kodó túꞌu na Véase
chindei kuití na̱
♦ nachikani kuití na̱ v. t. volver a

amontonar (una cantidad)
chikani na v. t. poner (parado), parar

(complemento singular) Ni ̱saꞌiṉ ni ̱
chiḵani iin soto noo ̱iṯíi.̱ Fui a poner
un espantapájaros en mis milpas.
[pres. chíkani na; pas. ni ̱chiḵani
na] Véase chikata na
♦ nachikani na v. t. volver a poner

(parado)
chikani ndaa na̱ v. t. recargar

(parado) Ni ̱chiḵani ndaa na̱
eskalerá dá ni ̱kaa na dini ̱véꞌe na.
Recargó la escalera para subir al techo
de su casa.
[pres. chíkani ndaa na;̱ pas. ni ̱
chiḵani ndaa na]̱ Véase chikata
ndaa na̱

chikani ndichi na̱ v. t. parar (derecho,
complemento singular)

[pres. chíkani ndichi na;̱ pas. ni ̱
chiḵani ndichi na]̱ Véase chikata
ndichi na̱

chikata na v. t. poner (parados),
parar (complemento plural) Chíkata na
diꞌiṉ veꞌe na. Ponen los horcones de
su casa.
[pres. chíkata na; pas. ni ̱chiḵata
na] Véase chikani na

chikata ndaa na̱ v. t. recargar
(parados) Chíkata ndaa na ̱dita ̱yuꞌú
xoo ̱ná ndítaan kadóaṉ. Está
recargando las tortillas en la orilla de
su comal para que se tuesten.
[pres. chíkata ndaa na;̱ pas. ni ̱
chiḵatandaa na]̱ Véase chikani ndaa
na̱

chikata ndichi na̱ v. t. parar
(derechos, complemento plural)
Véase chikani ndichi na̱

chikáti ̱ná v. i. dar sombra Ndéi na
kávaꞌ̱a na mvélo ̱saꞌa ̱yíto ̱káa, chi ̱
vaꞌ̱a ndavaꞌ̱o chíkáti ̱ra.̱ Ellos están
haciendo sombreros al pie de ese árbol
porque da buena sombra.
Deriv. de káti ̱ [pres. chíkáti ̱ná; pas. ni ̱
chiḵáti ̱ná]

chikerró s. esp. becerro

chikerró
chiḵí s. tuna Vidi ̱ndaꞌ̱o chiḵí kuaꞌá.

La tuna roja está muy dulce.
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chiḵí
chikii ̱ s. ampolla Ni ̱kana chikii ̱ini

ndáꞌí ni ̱kee ndaꞌá yataí̱. Me salieron
ampollas en la mano por la mancera
de mi arado.

chikiḻí na̱ v. t. hacer cosquillas Chíkiḻí
táꞌan xi ñíi ̱xí. Los niños se hacen
cosquillas unos a otros.
Deriv. de kiḻí ña̱ [pres. chíkiḻí na;̱ pas.
ni ̱chiḵiḻí na]̱

chikiꞌ̱ó na̱ v. t. pesar Koꞌoṉ na̱
chikiꞌ̱ó na ̱ndúchi ̱diḵó ná. Va a
pesar el frijol para venderlo.
Deriv. de kiꞌ̱o1 [pres. chíkiꞌ̱ó na;̱ pas.
ni ̱chiḵiꞌ̱ó na]̱

chikodó ná v. t. 1. poner (encima,
complemento plural) Ni ̱chiḵodó ná
koꞌo ̱noo ̱mesá kasáꞌan naṯóꞌo.̱ Puso
los platos en la mesa para las
personas.
2. apuntar, inscribir (complemento
plural) Xíonoo ta ̱néꞌe choon
chíkodó rá ku̱ú na ̱ñoo noo ̱tuti ra.̱
Las autoridades andan apuntando los
nombres de los habitantes del pueblo.
Deriv. de kodó ná [pres. chíkodó ná;
pas. ni ̱chiḵodó ná] Sinón. chindodó
ná Véase chinóo na

chikodó táꞌan na v. recíp. amontonar
(uno sobre otro) Chíkodó táꞌan na
rejá kirávidi.̱ Ellos amontonan rejas
de refresco uno sobre otro.
[pres. chíkodó táꞌan na; pas. ni ̱
chiḵodó táꞌan na]

chikoo̱ na v. t. 1. poner (sentado),
sentar (complemento singular) Ni ̱
chiḵoo̱ na deꞌ̱e na noo ̱iin téi ̱lóꞌo̱
kasáꞌan xi. Ella sentó a su niño en un
banquito para comer.
2. asentar (complemento singular)
Ndaa ̱dini ̱yúku̱ káa ni ̱chiḵoo̱ na iin
veꞌe lóꞌo ̱ió na.̱ En la cima del monte
asentaron una choza para vivir allí.
[pres. chíkoo̱ na; pas. ni ̱chiḵoo̱
na] Véase chindei na2

chikorrá na̱ v. t. rodear Ni ̱chiḵorrá
na ̱kuéi ̱ná, dá ni ̱kaṉdeé ná ni ̱tiin
na ri.̱ Ellos rodearon el caballo para
poder atraparlo.
Deriv. de korrá [pres. chíkorrá na;̱
pas. ni ̱chiḵorrá na]̱

chikúti ̱ná v. t. amarrar (en forma
ordenada) Chíkúti ̱ná tii̱ títo ̱kandio
na noꞌo ̱na.̱ Él está amarrando su leña
para llevarla a la casa.
[pres. chíkúti ̱ná; pas. ni ̱chiḵúti ̱ná]

chí meꞌ̱í adv. por el centro (de un
pueblo) Chí meꞌ̱í koo inoṉ kandaaoṉ
miíón. Por el centro tienes que cuidar
tu manera de portarte.
Comp. de chí, meꞌ̱í

chimekó adj. chimeco (color café con
rayas negras, reg.) Kuaꞌaṉ chee̱
chimekói ̱kuti rí. Se llevaron a mi
toro café con rayas negras para
trabajar en la siembra.

chína̱ part. pues (afirmación) Toꞌ̱on
kiꞌ̱o kaá ní koni, dión ná koo chína.̱
Como usted dijo ayer, así será pues.

chinaꞌá ná v. t. avisar, informar, dar a
conocer Kóꞌiṉ chinaꞌí na,̱ chi ̱ni ̱ku̱ꞌu
chee̱i ̱ni ̱sei ̱ri ̱iti. Voy a avisarle
porque entró mi toro a comer su
milpa.
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chiokaꞌanda na̱ {var. de chikaꞌanda
na}̱ pasar

chirakaa na {var. de chirkaa na}
colgar (complemento singular)

chirakuei na {var. de chirkuei na}
colgar (complemento plural)

chiranee na {var. de chirnee na}
poner (de forma horizontal); enchufar;
tender (ropa); comprometerse (fig.)

chirkaa na v. t. colgar, poner colgado
(complemento singular) Ni ̱chiṟkaa na
iin riatá noo ̱yíto,̱ dá ná kuu
kuriyáꞌó takuálí. Colgaron una reata
en el árbol para que se puedan
columpiar los niños.
[pres. chírkaa na; pas. ni ̱chiṟkaa na]
Var. chirakaa na Véase chirkuei na

chirkuei na v. t. colgar, poner
colgado (complemento plural)
Chírkuei na dáꞌoṉ ná noo ̱yóꞌo̱
nayaan. Cuelga la ropa en el mecate
para que se seque.
[pres. chírkuei na; pas. ni ̱chiṟkuei
na] Var. chirakuei na Véase chirkaa
na

chirndaa na̱ v. t. poner, pegar (en una
superficie, complemento plural) Ni ̱
chiṟndaa na ̱naꞌ̱áná na ̱ndiḵa veꞌe
na. Él puso sus fotografías en la pared
de su casa.
[pres. chírndaa na;̱ pas. ni ̱chiṟndaa
na]̱ Var. chindaa na̱ Véase chindaꞌa̱
na̱

chirnee na v. t. 1. poner, meter (de
forma horizontal) Ni ̱chiṟnee na tiṉ̃oó̱
kado ri ̱noo ̱mákina.̱ Pusieron pollos
en la máquina para rostizarlos.
2. enchufar
3. tender (ropa) Ni ̱chiṟnee na dáꞌoṉ
ná noo ̱yóꞌo ̱káa karkuei ña nayaa

ña. Ella tendió la ropa en el mecate
para que se seque.
4. comprometerse (fig.) Ni ̱chiṟnee na
mií ná noo ̱chóon. Ellos se
comprometieron a realizar el trabajo.
[pres. chírnee na; pas. ni ̱chiṟnee na]
Var. chinee na, chernee na, chiranee
na

chirríoṉ s. esp. chirrión, chicote Néꞌe
iin ta ̱ndáka kíti ̱chirríoṉ káni ̱rá kíti ̱
rá. El pastor de chivos lleva un
chicote para controlarlos.

chirroní s. esp. chicharrón Dákadó na̱
chirroní tiṉ̃iꞌ̱í keí ná. Ellas están
cociendo chicharrón de zorrillo para
comer.

chisáꞌá ná v. t. patear Ni ̱ku̱xoo na
kuaꞌaṉ na,̱ dá chi ̱yu̱ꞌú na ̱chisáꞌá ñá
kuéi.̱ Se apartó de allí porque tiene
miedo de que el caballo lo patee.
Deriv. de saꞌa̱ [pres. chísáꞌá ná; pas. ni ̱
chis̱áꞌá ná]

chí sata̱ adv. 1. por atrás, hacia atrás
Kuaꞌán chí sata.̱ Vete hacia atrás.
2. en tiempo pasado, antes Sa ̱saꞌanda
na ̱tooṉ chí sata.̱ Antes hacían
carbón.
Comp. de chí, sata̱ Véase tá sata̱

chíta̱ s. cuajilote (fruta semejante al
plátano, reg.) Vaꞌ̱a cháá ka ̱sáꞌaṉ
chíta,̱ tá kée xitóaṉ. Los cuajilotes
son más sabrosos si los hornean.
♦ tac̱híta̱ s. cuajilote (árbol, reg.)

chítí díní ñá {pres. de kutí díní ñá}
está llenándose (completamente)

chítí ná {pres. de kutí ná} está
llenándose

chitó s. gato
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[pres. chíníꞌini ndáꞌa ̱ná; pas. ni ̱
chiṉíꞌini ndáꞌa ̱ná]

chí niṉo adv. arriba, por arriba Ko̱
taꞌ̱ón taḵuií̱ chí niṉo káa; chí nino̱
káa va ió taḵuií̱. Por allá arriba no
hay agua, pero hacia abajo hay agua.
Comp. de chí, niṉo

chí noo̱ adv. 1. adelante Chí noo ̱káa
xíin na mvélo.̱ Por allá adelante
compran sombreros.
2. en adelante Viti chí noo ̱koo inoṉ
ndísáꞌano keeón. De hoy en adelante
trata de hacer el bien.
Comp. de chí, noo1̱

chinóo kuac̱hi na v. t. culpar
(lit. poner pecado sobre) Chínóo
kuac̱hi na yuꞌu̱ ña ̱kítií̱ ni ̱seí iti na,̱
kaá na.̱ Me culpan diciendo que mis
animales se comieron sus milpas.
[pres. chínóo kuac̱hi na; pas. ni ̱
chiṉóo kuac̱hi na]

chinóo na v. t. 1. poner (encima,
complemento singular) Chinóo mvélo̱
dinoṉ, chi ̱iꞌíní ndaꞌ̱o. Ponte tu
sombrero porque hace calor.
2. añadir (complemento singular) Vaꞌ̱a
ka ̱ná chinóoi iin ka ̱yíko ̱ndoꞌ̱o noo̱
náo ̱veꞌi, chi ̱ni ̱kaṉdoo̱ nino ̱van. Es
mejor que yo añada otra hilera de
adobe a la pared de mi casa, porque
quedó baja.
3. poner (rebozo o sarape a otra
persona)
4. apuntar, inscibir (complemento
singular) ¿Á kee ní ña ̱mani ̱chinóo
ní kuendá yóꞌo noo ̱tuti? Por favor,
apunte esta cuenta en la lista.
[pres. chínóo na; pas. ni ̱chiṉóo
na] Véase chindodó ná, chikodó ná

♦ nachinóo na v. t. volver a poner
(encima); volver a apuntar (en una
lista, complemento singular)

chinóo vaꞌ̱a na v. t. 1. guardar,
acomodar (complemento singular)
Chínóo vaꞌ̱a na radio na,̱ dá o̱
kánkao ña. Acomodó bien su radio
para que no se caiga.
2. hacer que viva bien (complemento
singular)
[pres. chínóo vaꞌ̱a na; pas. ni ̱chiṉóo
vaꞌ̱a na] Véase chindei vaꞌ̱a na

chiñoꞌómá na̱ v. i. 1. echar humo (de
incienso) Chíñoꞌómá na ̱noo ̱náa ̱ná.
Ellos echan humo de incienso en su
altar.
2. echar humo (para remedio o
purificación) Chíñoꞌómá na ̱taleé
xíꞌín suká xíꞌín yaꞌá kuaán tá kúꞌu̱
xi.̱ Ellos queman azúcar y chile
amarillo para echarle el humo al niño
cuando está enfermo.
Deriv. de ñoꞌom̱a̱ [pres. chíñoꞌómá
na;̱ pas. ni ̱chiṉ̃oꞌ̱ómá na]̱

chiñoꞌo na v. t. poner (un sombrero a
otra persona) Ni ̱chiṉ̃oꞌo na xi iin
mvélo,̱ dá kuaꞌaṉ xi yúku̱, chi ̱iꞌíní
ndaꞌ̱o. Le puso al niño un sombrero
para que vaya al monte, porque hace
mucho calor.
[pres. chíñoꞌo na; pas. ni ̱chiṉ̃oꞌo na]

chiñóꞌo ̱na̱ v. t. 1. quemar Ni ̱chiṉ̃óꞌo̱
na ̱iin yíto ̱ichí íin kétéin noo ̱ñóꞌo̱
ná. Quemaron un árbol que estaba
estorbando en su terreno.
2. encender Ni ̱chiṉ̃óꞌo ̱na ̱íti ̱ni ̱kei ̱
noo ̱ná saḵuaá kóni. Ellos
encendieron una vela para alumbrar la
casa ayer en la noche.
Deriv. de ñóꞌo1̱ [pres. chíñóꞌo ̱na;̱ pas.
ni ̱chiṉ̃óꞌo ̱na]̱
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Deriv. de kanaꞌá ná [pres. chínaꞌá ná;
pas. ni ̱chiṉaꞌá ná]
♦ nachinaꞌá ná v. t. volver a

informar; jurar
chinaꞌa ̱na̱ v. t. marcar, trazar

(medidas) Ni ̱chiṉáꞌa ̱na ̱ray̱á noó̱
kakuu saꞌa ̱véꞌe. Marcaron con rayas
donde se va a poner el cimiento de la
casa.
Deriv. de nanaꞌa̱ na,̱ kanaꞌa̱ ña̱ [pres.
chínaꞌa ̱na;̱ pas. ni ̱chiṉáꞌa ̱na]̱

chiṉáꞌano adj. grandísimos, enormes
Káa ndíta yúku̱ chiṉáꞌano. Allá hay
cerros grandísimos.
Véase chiḵáꞌano

chiṉáni ̱ {pl. de chiḵáni}̱ muy largos,
muy altos

chinaní kini na v. t. llamar (malo),
difamar
[pres. chínaní kini na; pas. ni ̱
chiṉaníkini na]

chinaní ná v. t. poner (nombre),
nombrar
Deriv. de kananí ná [pres. chínaní ná;
pas. ni ̱chiṉaní ná]

chinaní tóꞌón ná v. t. llamar
(mentiroso), difamar Ni ̱chiṉaní tóꞌón
ná yuꞌu̱ ña ̱kánii chee̱ na,̱ kaá na,̱
tído ko ̱ní kána taꞌan kakian ña̱
ndaa.̱ Ellos me llaman mentiroso;
dijeron que yo les pego a sus vacas,
pero no es cierto.
[pres. chínaní tóꞌón ná; pas. ni ̱
chiṉanítóꞌón ná]

chindaa na̱ {var. de chirndaa na}̱
pegar (en una superficie, complemento
plural)

chindaá na̱ v. t. 1. raspar Chíndaá
kíti ̱dini ̱ri ̱ndiḵa yíto.̱ Los chivos se
raspan la cabeza en los árboles.

2. untar Chíndaá na ̱sití seí yo ̱ndáꞌa̱
ná noo ̱ni ̱kei.̱ Ella unta aceite
comestible donde se quemó la mano.
[pres. chíndaá na;̱ pas. ni ̱chiṉdaá
na]̱

chindaa ̱na̱ v. t. cortar (camino),
tomar (un atajo) Yachi ̱va ni ̱saa ̱na̱
chi ̱ni ̱chiṉdaa ̱na ̱íchi.̱ Él llegó
pronto, porque cortó camino.
[pres. chíndaa ̱na;̱ pas. ni ̱chiṉdaa̱
na]̱

chindaꞌá ná v. t. 1. empujar Ni ̱
saꞌanda na ̱saꞌa ̱yíto;̱ dá ni ̱chiṉdaꞌá
ná ra;̱ dá ni ̱yaa ̱ra.̱ Cortaron el
tronco del árbol; después lo
empujaron; entonces se cayó.
2. enviar, mandar (a hacer algo) Ni ̱
chiṉdaꞌá ná deꞌ̱e na kuaꞌaṉ xi ̱kuio̱
xi títo.̱ Ellos mandaron a su hijo a
traer leña.
Deriv. de ndáꞌa̱ [pres. chíndaꞌá ná;
pas. ni ̱chiṉdaꞌá ná]

chindaꞌa ̱na̱ v. t. poner, pegar (en una
superficie, complemento singular) Ni ̱
chiṉdáꞌa ̱na ̱naꞌ̱áná na ̱ndiḵa veꞌe
na. Ellos pusieron su fotografía en la
pared de la casa.
[pres. chíndaꞌa ̱na;̱ pas. ni ̱chiṉdáꞌa̱
na]̱ Véase chirndaa na̱

chindaꞌá níꞌini na v. t. empujar
Chíndaꞌá níꞌini na vaká na ̱dá xíka
rí, chi ̱kúꞌu̱ va rí. Está empujando a
su vaca para que camine porque está
enferma.
Comp. de ndáꞌa,̱ niꞌini [pres.
chíndaꞌáníꞌini na; pas. ni ̱
chiṉdaꞌáníꞌini na]

chindaa ̱noo ̱ná v. i. 1. ser
precipitado Ko ̱ndáti tóo na dá kaꞌaṉ
na;̱ chíndaa ̱noo ̱ná, saꞌ̱á ñoó̱ dátu̱ú
ná choon. No piensa en sus palabras;
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es muy precipitado. Por eso echa a
perder cualquier asunto.
2. atreverse Chíndaa ̱noo ̱xí kée xi
ñaꞌ̱a, saꞌ̱á ñoó̱ ni ̱kani ñaá na ̱veꞌe
xi. Él se atreve a hacer las cosas, por
eso sus padres lo disciplinaron.
[pres. chíndaa ̱noo ̱ná; pas. ni ̱
chiṉdáaṉoo ̱ná.]

chindayaꞌ̱i na v. t. 1. alabar,
engrandecer Chíndayaꞌ̱i na ta ̱néꞌe
choon, chi ̱keyíko ̱vaꞌ̱a ra saꞌa ̱ná.
Ellos alaban a la autoridad porque les
hace justicia.
2. sentirse orgulloso Chíndayaꞌ̱i na
mií ná tá kándéé ná kée na iin ñaꞌ̱a.
Se siente orgulloso cuando puede
hacer algo.
Deriv. de ndáyaꞌ̱i na, kandayaꞌ̱i na
[pres. chíndayaꞌ̱i na; pas. ni ̱
chiṉdayaꞌ̱i na]

chindeé ná v. t. ayudar, apoyar Ni ̱
chiṉdeé ná yuꞌu̱ tá ni ̱kav̱aꞌ̱a veꞌi.
Me ayudaron cuando construí mi casa.
[pres. chíndeé ná; pas. ni ̱chiṉdeé
ná]

chindeé ná míí ná v. i. defenderse
[pres. chíndeé ná míí ná; pas. ni ̱
chiṉdeé ná míí ná]

chindeé táꞌan na v. recíp. ayudar
(mutuamente) Chíndeé táꞌan na noó̱
kávaꞌ̱a na veꞌe na. Se ayudan unos a
otros para construir sus casas.
[pres. chíndeé táꞌan na; pas. ni ̱
chiṉdeé táꞌan na]

chindei kuití na̱ v. t. amontonar
(complemento plural) Ni ̱chiṉdei kuití
yo ̱níi.̱ Amontonamos mazorcas en el
suelo.
Deriv. de kuití2 [pres. chíndei kuití
na;̱ pas. ni ̱chiṉdeikuití na]̱ Véase
chikani kuití na̱

chindei na1 v. t. poner, tender (en el
suelo, complemento plural) Chíndei
vaꞌ̱a na títo ̱ná saꞌa ̱véꞌe na. Ellos
ponen la leña en el suelo, junto a la
pared de la casa.
Deriv. de kandei na2 [pres. chíndei
na; pas. ni ̱chiṉdei na] Véase
chinduꞌu̱ ná
♦ nachindei na v. t. volver a poner

(en el suelo)
chindei na2 v. t. poner, sentar, asentar

(complemento plural) Chíndei na deꞌ̱e
na yuꞌú nóꞌo ̱kasáꞌan xi. Ella sienta a
sus hijos junto a la lumbre para que
coman.
Deriv. de kandei̱ na [pres. chíndei na;
pas. ni ̱chindei na] Var. chindei̱
na Véase chikoo̱ na
♦ nachindei vaꞌ̱a na v. t.

reconciliar
chindei nduu na̱ v. t. tener listos

(complemento plural) Ni ̱chiṉdei nduu
na ̱títo,̱ táꞌaṉ kirá choꞌo ̱ndaḵí kuu̱
víko.̱ Ellos tienen lista la leña para
cocer el pozole en el día de la fiesta.
Deriv. de nduu [pres. chíndei nduu
na;̱ pas. ni ̱chiṉdei nduu na;̱ compl.
sing. chinduꞌu̱ nduu na]̱

chindei vaꞌ̱a na v. t. 1. guardar,
acomodar (complemento plural) Koꞌoṉ
na ̱chindei vaꞌ̱a na ndáyoꞌ̱o ini veꞌe,
dá ná o ̱ndáxian kee dai.̱ Ellos van a
guardar los zacates en la casa para que
no se mojen con la lluvia.
2. hacer que vivan bien (complemento
plural) Ió diꞌ̱ón na,̱ saꞌ̱á ñoó̱ kándéé
ná chíndei vaꞌ̱a na deꞌ̱e na, saꞌ̱á ñoó̱
ko ̱kámani ̱ñaꞌ̱a noo ̱xí. Ellos tienen
dinero, por eso pueden hacer que
vivan bien a sus hijos sin necesidades.
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Deriv. de kandei vaꞌ̱a ña [pres.
chíndei vaꞌ̱a na; pas. ni ̱chiṉdei vaꞌ̱a
na] Véase chinóo vaꞌ̱a na

chindei xoo na v. t. apartar, separar
(complemento plural) Ni ̱chiṉdei xoo
na titó ic̱hí na ̱xíꞌín títo ̱kuíi.̱ Ellos
separan la leña seca de la leña verde.
[pres. chíndei xoo na; pas. ni ̱chiṉdei
xoo na] Sinón. taó xóo na Véase
chinduꞌu̱ xoo na

chindei yáó ná v. t. extender (sobre
algo, complemento plural) Ni ̱chiṉdei
yáó ná ndic̱hi na ̱noo ̱iin yúu̱ dá
ichia̱ṉ. Extendió los ejotes en un
petate para que se sequen.
Deriv. de yáó [pres. chíndei yáó ná;
pas. ni ̱chiṉdei yáó ná] Var. chindei
yádí na̱

chiṉdó adj. 1. grandes y salidos (ojos,
por asombro o enojo) Chiṉdó ndaꞌ̱o
noó̱ tiṉ̃omi yu̱ú; kini ndaꞌ̱o ndéꞌé rí.
Son muy grandes los ojos del búho; su
mirada es muy fea.
2. grandes y crecientes (nubes) Tá
chiṉdó ndaꞌ̱o noó̱ viko ̱ni ̱nana noo̱
yúku̱, dá kíaṉ koon dai ̱ndéé.
Cuando hay nubes grandes en los
cerros, entonces va a llover recio.
3. frondoso (planta, árbol) Torá ni ̱dii
iti káaan, tor ni ̱koon dai ̱ndéé,
nduchiṉdó ndavaꞌ̱o noo ̱ndáꞌa ̱ñá. Si
se marchitan las milpas y llueve recio,
se ponen muy frondosas las hojas de
las milpas.
♦ kandeꞌ̱é chiṉdó na̱ v. t. mirar

(con expresión de enojo o asombro)
♦ noo ̱chiṉdó adj. con mirada

fuerte (y ojos muy grandes)
chindodó ná v. t. poner (encima,

complemento plural) Chíndodó ná
deꞌ̱e na sata ̱kuéi ̱ná, dá kuaꞌaṉ na̱

yúku̱. Ponen a sus hijos sobre el
caballo para ir al monte.
[pres. chíndodó ná; pas. ni ̱chiṉdodó
ná] Sinón. chikodó ná Véase chinóo
na

chinduꞌu̱ ná v. t. 1. poner, tender (en
el suelo, complemento singular) Ni ̱
chiṉdúꞌu̱ ná iin yuu̱ káa toꞌ̱on káa
tiy̱oó̱ yéꞌé chóon na.̱ Ellos pusieron
una piedra con forma de tortuga en el
patio de la agencia municipal.
2. establecer (fig.) Nda ̱rá sa ̱káa̱
ñoo, nda ̱daá vá ni ̱chiṉdúꞌu̱ na ña̱
kandéi ta ̱néꞌe choon. Desde que
fundaron el pueblo, en aquel entonces
establecieron que haya autoridades.
Deriv. de kanduꞌu̱ ná, nanduꞌu̱ ná
[pres. chínduꞌu̱ ná; pas. ni ̱chiṉdúꞌu̱
ná] Véase chindei na1

chinduꞌu̱ nduu na̱ {compl. sing. de
chindei nduu na}̱ tener listo

chinduꞌu̱ xoo na v. t. separar
(complememto singular)
Sinón. taó xóo na Véase chindei xoo
na

chinee na {var. de chirnee na} poner
(de forma horizontal); enchufar; tender
(ropa); comprometerse (fig.)

chiníꞌini na v. t. fregar, tallar
Chíníꞌini vaꞌ̱a na dáꞌoṉ, dá ná
ndooan. Ella está tallando bien la
ropa para que quede limpia.
Deriv. de niꞌini [pres. chíníꞌini na;
pas. ni ̱chiṉíꞌini na]

chiníꞌini ndáꞌa ̱ná v. t. frotar (con las
manos) Koꞌiṉ chiníꞌini ndáꞌí yuku̱
kakuu tata ̱kuchi iin tadiꞌí kúꞌu̱.
Voy a frotar la hierba con las manos
para preparar una medicina para que
se bañe la muchacha enferma.
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